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CITations is a report featuring information technology-related news of interest to UNC-Chapel Hill faculty members,
graduate instructors and the staff who support them. CITations, published twice a month, is an electronic service of
the ITS Center for Instructional Technology.
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ITRC Tip: Automatically Format Additional List Items in Excel 2000
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October 1999 Issue of CIT Infobits
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How to Subscribe or Unsubscribe to CITations

COPYRIGHT TALK

You are invited to attend the next brown-bag lunch meeting of the UNC-Chapel Hill Scholarly Communications Working
Group. The topic for the November meeting will be on copyright. Peggy Hoon, Scholarly Communication Librarian at
NCSU, updates us on recent copyright legislation and how it affects university faculty and staff who create and/or use
copyrighted materials. The meeting is on Tuesday, November 9, noon-1:00 p.m. in the Davis Library Conference
Rooms, 2nd Floor, Davis Library. Bring your lunch; soft drinks and cookies are provided.

For more information on NCSU's Scholarly Communication Center, see their Website at
http://www.lib.ncsu.edu/libraries/SCC/

The UNC-Chapel Hill Scholarly Communication Working Group is a multidisciplinary problem-centered group with a
broad concern for all dimensions of contemporary scholarly communication. For more information see their Website at
http://ils.unc.edu/schol-com/index.html

CHANGE IN EXAM SCANNING SERVICE

Beginning on January 3, 2000, you must drop off and pick up your scanning requests for exams, evaluations, and
surveys only at the Center for Instructional Technology (CIT) offices in the lower level of Smith Building. As you may
know, our scanning service moved from the ITRC in Wilson Library to a new location in the CIT offices in July. At that
time, we allowed scanning requests to be dropped off at either the ITRC in Wilson or at the CIT offices. This change, to
a single drop off and pick up location, is being made to streamline services and to ensure the same high-quality
service, security, and confidentiality that you have come to expect.

The CIT offices are located in the lower level of Smith Building just off Cameron Avenue, next to Swain Hall. The
entrance to the CIT offices is in the middle of the building on the side of Smith that faces Swain Hall. Go down the
exterior stairs, through the door, and the CIT signs will guide you the rest of the way. Once in the CIT office, the
Scanning Service office is straight ahead. You can ask any of the CIT consultants in our suite to point the way.

If you have any questions, please call Kathy Thomas at 962-5283.

http://www.unc.edu/
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http://its.unc.edu/teac/
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ITRC TIP: MOVING HIBERNATION FILE ON THINKPAD SYSTEMS

At the IT Response Center, we have had users ask how to free up more disk space on their C partition. On the
Thinkpad systems, you can move the Hibernation file from the C to the D partition. The move will save you roughly
130 Megabytes on the TP 600s.

Here's the procedure:

1. Go to START--> RUN

2. Type 'command' in the text field

3. At the DOS prompt, type 'ps2 hfile del'

4. Then type 'ps2 hfile d' (This step will create the Hibernation file on D)

5. Exit DOS

6. Change a line in AUTOEXEC.BAT {Change from: PS2 HFILE C} {Change to: PS2 HFILE D}

If you have any questions about the procedure, contact the IT Response Center at 962-HELP.

ITRC TIP: AUTOMATICALLY FORMAT ADDITIONAL LIST ITEMS IN EXCEL 2000

When adding new items to a formatted list, Excel 2000 will automatically extend the formatting to include the new
items, thus saving users a few additional steps. Just use the "Extended Formats And Formulas" option.

The feature will work if at least three of the preceding five rows have the same format. For example, you have five
items listed in cells A2 through A6. Format the items. In cell A7, add a new item to the list. When you press the Enter
keys, the new item is formatted to match the preceding items.

Similarly, this feature copies down a formula if the preceding rows contain the same formula. For example, suppose
you have several rows of data in columns B through G with column H containing a formula at the end of each row.
When you add a new row of data to the bottom of the list and press the Enter key for the last item of data, the
formula will be filled in the last cell for that row.

To turn this option on or off, from the Tools menu bar, select Options and click on the Edit tab. On the right side of the
dialog box, either select or deselect the "Extend List Formats And Formulas" check box.

Thanks to Bryan Ayers in the Information Technology Response Center for making ITRC Tips available to CITations
readers.

For more computing assistance, contact the Information Technology Response Center, Wilson Library, Suite 300
Walk-in Hrs: 7:30 a.m. to 5 p.m.
Phone: 962-HELP - 24 hours 
Email: help@unc.edu

CBT TIP: MICROSOFT OFFICE 2000: CREATING A TABLE OF CONTENTS IN WORD

The tip below can be found in the "Microsoft Office 2000: Advanced Word" online CBT course. To access this CBT
course, please follow this link: http://help.unc.edu/cbt/curicula/courses/msof23e/msof23e.htm

A Table of Contents is useful because it provides an overview of the topics covered in a particular document and it
helps to navigate through a document. A TOC can include hyperlinks from each heading to the topic in the document
to which it relates, so your readers will not need to scroll through pages and pages of text trying to find the
information that they need. Creating a TOC is a simple process.

1. Before you create a TOC, you need to ensure that your document headings correspond to the levels that you want
reflected in your TOC.
You can do this by:
a. using built-in heading styles
b. using outline-level formats
c. customizing headline styles

2. First, position your insertion point where you want to place the TOC.

mailto:help@unc.edu
http://help.unc.edu/cbt/curicula/courses/msof23e/msof23e.htm
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3. Select Index and Tables from the Insert menu.

4. Click the Table of Contents tab in the Index and Tables dialog box.

5. Then select a format for your TOC from the Formats drop-down list.

6. Type the number of heading levels in the Show Levels box.

7. Click OK to include the TOC in your document.

8. You can modify the heading styles of your TOC by selecting the "From template" option in the Formats drop-down
menu and clicking on the Modify button. This brings you to the Style dialogue box where you can modify styles as
usual.

Thanks to Sari Schwartz in ATN for making this information available to CITations readers.

FEATURED CBT COURSE: MICROSOFT OFFICE 2000: BEGINNING POWERPOINT

Make sure your presentation is effective and memorable. Exploit PowerPoint's powerful features and enjoy a program
that lets you create powerful slide shows quickly and easily.

The CBT course "Microsoft Office 2000: Beginning PowerPoint" gets you started with this flexible program. After just
one course, you'll already be able to make a good-looking presentation. You'll be able to:

· create a new presentation
· use the Office and Presentation Assistants
· copy, delete, and modify the sequence of slides
· format and edit the text in slides
· insert Clip Art, pictures, movies and sounds
· prepare a presentation
· save a presentation in normal and HTML modes
· print audience and speaker notes
· email your presentation to someone

The course can either be downloaded to your hard drive, or simply taken online from within your favorite web
browser. You should be familiar with the basics of getting around in Windows to get the most out of this course. The
course URL is http://help.unc.edu/cbt/curicula/courses/msof33e/msof33e.htm

Find out all about CBT courses at UNC-Chapel Hill by visiting http://help.unc.edu/cbt/
Thanks to Cheryl Lytle, ATN Computer Training Center for making CBT course information available to CITations
readers.

OCTOBER 1999 ISSUE OF CIT INFOBITS

Infobits is an electronic service of ATN/CIT. Each month the CIT's Information Resources Consultant monitors and
selects from a number of information technology and instructional technology sources that come to her attention and
provides brief notes for electronic dissemination to educators. The latest issue is available on the Web at
http://www.unc.edu/cit/infobits/bitoct99.html

Articles in this issue include:

1999 Campus Desktop Computing Survey 
Electronic Class Discussion Handbook 
Moving Your Course to the Web 
Ten Good Deeds in Web Design 
Online Journal Comments on Trends in Computing 
Top 100 Books in Libraries 
Gothic Literature Online 
Recommended Reading

To subscribe to Infobits, contact Carolyn Kotlas, kotlas@email.unc.edu

NOVEMBER-DECEMBER ISSUE OF THE TECHNOLOGY SOURCE

The purpose of The Technology Source is to provide thoughtful, illuminating articles that will assist educators as they
face the challenge of integrating information technology tools into teaching and into managing educational

http://help.unc.edu/cbt/curicula/courses/msof33e/msof33e.htm
http://help.unc.edu/cbt/
http://www.unc.edu/cit/infobits/bitoct99.html
mailto:kotlas@email.unc.edu
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organizations. The Technology Source is edited by James Morrison, professor in the UNC-Chapel Hill School of
Education.

Articles in the latest issue include:

"Higher Education in 2010: An Interview with Rodney L. Everhart," by James L. Morrison
"Web-based Learning: Extending the Paradigm," by Dirk Rodenburg
"Avatar Pedagogy," by Joel Foreman
"Professional Development: Going Online," by Angie Parker
Case Studies:
"Indiana State's Multiple Delivery Approach: Integrating Industrial Technology Education with Educational Technology,"
by Chris Zirkle and Hal Shoemaker
"Leading the Pack: From an On-Campus Program to Internet-Based Delivery," by Mary Anne Nixon and Beth Rodgers
Leftwich

The Technology Source is available on the Web at http://horizon.unc.edu/TS/

ON THE HORIZON

The September-October 1999 issue of On the Horizon is now available online at
http://horizon.unc.edu/horizon/online/html/7/5/

On the Horizon On-Line is a strategic planning publication published in print form by Jossey-Bass publications and
published under contract in online form by UNC-Chapel Hill. James Morrison, professor in the UNC-Chapel Hill School of
Education, edits the journal. Links to back issues are on the Web at http://horizon.unc.edu/horizon/online/

In the September-October 1999 issue:

"Information Technology in Higher Education: The 'Global Academic Village' and Intellectual Standardization," by Phil
Agre, Department of Information Studies, University of California, Los Angeles

"Space: The Final Frontier," by Donald M. Norris, President, Strategic Initiatives, Inc.

"On the Tenure of University Presidents," by Sujit Ghosh and Arthur Padilla, North Carolina State University

"Democracy and the Academy," by Laurence R. Marcus, Professor in Educational Leadership, Rowan University

CONFERENCE ANNOUNCEMENTS

Keep informed about technology conferences with the CIT's "Calendar of World-Wide Educational Technology-Related
Conferences, Seminars, and Other Events." The calendar is on the Web at http://confcal.unc.edu:8086/

1999/2000 CITATIONS PUBLICATION SCHEDULE

November 19 
December 3 
December 17
January 14
January 28
February 11
February 25
March 10
March 24

CITations welcomes announcements from all UNC-Chapel Hill campus organizations involved in instructional and
research technology. To have an announcement considered for publication in CITations, send email to Carolyn Kotlas,
kotlas@email.unc.edu, or call 962-9287. The deadline for submissions is 11:00 a.m. the day before the publication
date.

HOW TO SUBSCRIBE OR UNSUBSCRIBE TO CITATIONS

CITations is published twice a month by the Center for Instructional Technology. Back issues are available on the CIT
Website at http://www.unc.edu/cit/citations/

For more information about the CIT, see our Website at http://www.unc.edu/cit/ or contact our office at 962-6042.

http://horizon.unc.edu/TS/
http://horizon.unc.edu/horizon/online/html/7/5/
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To subscribe on the Web link to http://mail.unc.edu/lists/read/subscribe?name=citations

To subscribe by email to CITations, send email to listserv@unc.edu with the following message: 
subscribe citations firstname lastname
substituting your own first and last names.
Example:
subscribe citations Nick Park

To unsubscribe to CITations, send email to listserv@unc.edu with the following message: 
unsubscribe citations

[Note: do not include your email address or name when unsubscribing.]

http://mail.unc.edu/lists/read/subscribe?name=citations
mailto:listserv@unc.edu
mailto:listserv@unc.edu
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